# TABLE OF CONTENTS

**Introduction** ............................................................................................................. 5
  Safety Precautions and Protection............................................................................. 5
**Overview** .................................................................................................................. 6
  Unpacking the Afinia H-Series 3D Printer ............................................................ 7
**Installing the Afinia H-Series 3D Printer** ............................................................ 8
  Attaching the Material Spool ................................................................................ 8
  Driver and Software Installation ........................................................................... 9
  Installing the Printer ............................................................................................. 9
**Getting Ready to Print** ........................................................................................... 11
  Starting the Afinia 3D Program ........................................................................... 11
  Initializing the Printer ........................................................................................... 11
  Preparing the Platform ....................................................................................... 12
  Leveling the Print Platform ................................................................................. 13
  Calibrating the Nozzle Height ............................................................................. 13
  Platform Level Calibration .................................................................................. 14
  Loading the Print Material Filament ................................................................... 16
  Other Maintenance Options ............................................................................... 16
**Printing with the H-Series 3D Printer** .................................................................... 18
  Loading a 3D Model .......................................................................................... 18
  View Options ..................................................................................................... 20
  Model transformations ....................................................................................... 20
  Placing Models onto the Build Platform ............................................................. 22
  Print Setup Options ........................................................................................... 23
  Printing .............................................................................................................. 26
  Print Options ...................................................................................................... 27
**Save as Project** .......................................................................................................... 28
**Model Removal** ...................................................................................................... 29
  Removing Support Material ............................................................................... 30
**Maintenance** .......................................................................................................... 31
  Changing the Material ....................................................................................... 31
  Vertical Calibration ............................................................................................ 31
  Cleaning the nozzle ........................................................................................... 32
  Removing / Changing the Nozzle ...................................................................... 33
  Cleaning the Platform ........................................................................................ 33
  Lubrication of bearings ...................................................................................... 33
  Spare parts ........................................................................................................ 33
**Tips & Tricks** ............................................................................................................. 34
**Status Indicator** ..................................................................................................... 36
**Troubleshooting** .................................................................................................... 37
  Solution for "Winusb.dll not found" problem (Windows) ..................................... 37
**Updating the Printer ROM** ..................................................................................... 39
**Specifications** .......................................................................................................... 39
  Printer Physical Characteristics ........................................................................ 39
  Specifications .................................................................................................... 39
  Environmental specifications ............................................................................. 39
**Technical Support** .................................................................................................. 40
Afinia 1-Year Limited Warranty

Below is the one-year limited warranty included with this Afinia product. Afinia prides itself on its outstanding product line and its technical support. If for some reason, your product fails, Afinia, a division of Microboards Technology, LLC, stands behind its warranties and assures you the best service possible in a quick and timely manner.

Afinia warrants to the original purchaser that this product is free from defects in material and workmanship. Afinia will for one year, at its option, repair or replace at no charge for parts and labor from the date you purchased the product from an authorized Afinia reseller. Nozzles and Cell/Perf Boards are warranted for ninety (90) days.

- Warranty registration must be completed within 30 days of receipt of the product in order to validate the warranty.
- Afinia, a division of Microboards Technology, LLC, reserves the right to determine the validity of all warranty claims.
- Warranty is void if the product serial number has been altered or removed.
- Warranty is void if the product has been misused or damaged or if evidence is present that the product was altered, modified, or serviced by unauthorized service people.

The above stated warranty is exclusive and replaces all other warranties, express or implied, including those of merchantability and fitness for a particular purpose. Afinia, a division of Microboards Technology, LLC, will not be liable for any other damages or loss, including incidental or consequential damages and loss of profits or revenues from whatever cause, including breach of warranty or negligence.

This product has been thoroughly tested and inspected at the factory prior to shipment. Nevertheless, inspect your product completely for any damage or loss of parts that may have occurred during shipment. Notify the delivering carrier promptly if damage claims are to be filed.

Afinia reserves the right to modify or update its product without obligation to replace any equipment delivered prior to any such change.

To register your warranty, please visit www.afinia.com/register

FCC ID: 026-H479

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
Introduction

Congratulations on purchasing an Afinia H-Series 3D Printer. The Afinia H-Series 3D Printer is designed with ultimate portability and simplicity in mind. The system and software allow you to print great models in a few easy steps, even if you have never used a 3D printer before. The Afinia H-Series 3D printer combines years of experience and innovation to make printing 3D models easy through its reliably simple hardware and software design.

Safety Precautions

Please read this section carefully before using the printer.

- The printer can only be used with the power adapters supplied by this company, or the product may be damaged, with a risk of fire.
- To avoid burning or model deformation, do not touch the model, nozzle, or the platform by hand or any other part of the body while the printer is working or immediately after it has finished printing.
- Protective glasses should always be worn when removing support material, especially PLA.
- The brown sections of the currently supplied gloves melt at around 200º C; please do not hold the extruder block with the gloves.
- There is a slight smell from ABS when it is being extruded. A well-ventilated room is recommended; however when printing, keep the printer away from any drafts as this can affect the warping of ABS prints.
- When ABS is burnt it releases toxic fumes. Never set the nozzle temperature high enough to burn the material.

The following classifications are used in this manual:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="exclamation.png" alt="Exclamation Mark" /></td>
<td>CAUTION: Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury.</td>
</tr>
<tr>
<td><img src="exclamation.png" alt="Exclamation Mark" /></td>
<td>WARNING: Indicates a potentially hazardous situation which, if not avoided, may result in serious injury.</td>
</tr>
<tr>
<td>🧼</td>
<td>GLOVES: When performing certain maintenance procedures, the machine may be hot and gloves are required to avoid burns.</td>
</tr>
<tr>
<td>🕶️</td>
<td>SAFETY GLASSES: Wear safety glasses to avoid injury to your eyes.</td>
</tr>
</tbody>
</table>

Protection

- The printer must not be exposed to water or rain, or damage may occur.
- Do not shut down the Afinia H-Series 3D System or pull out the USB cable when loading a digital model or the model data may be lost.
- When using the “Extrude” function, keep at least 50mm between the nozzle and the platform. If too close, the nozzle may get blocked.
- The printer is designed to work properly at an ambient temperature of between 60°F and 85°F and humidity of between 20% and 50%. Operating outside these limits may result in low quality models.
Overview

The Afinia H-Series 3D Printer primarily consists of the Extruder, Print Platform, Material Spool, and Filament, all supported by the Pedestal. The Printer is initialized with a single switch, and calibrating the position of the print platform is done using the included Afinia software.

The Afinia 3D software sends the print data from a Mac or PC to the Printer over a single USB cable. The Print Platform moves both vertically and front-to-back while the Extruder moves left-to-right, providing the necessary 3 axes of operation (see Figure 2). The Extruder delivers the Filament from the Material Spool into the Nozzle, which heats the filament to printing temperature and deposits it on the Platform.

Figure 1: Front and Back views of the Afinia H-Series 3D Printer

Figure 2: Axes of Operation
Unpacking the Afinia H-Series 3D Printer

Remove the Installation Disc, Manual, Quick Start Guide, and Accessories Pack from the box. Next, lift the Afinia H-Series 3D printer from the box. Remove the foam from both sides of the Printer and set the Printer on its base with the back of the Printer facing you.

There are 2 packaging clips that protect the Printer during shipping that need to be removed. Both clips should be saved in the event that you need to ship the Printer in the future!

The first clip to be removed is used to hold the Extruder assembly in place during shipping. Carefully peel the strapping tape down, and then slide the clip down and off the Printer.

The second clip is used to help keep the Platform Arm secure during shipping. To remove the clip, place your hand under the platform X-axis arm and gently lift. Do not lift the arm by holding onto the platform!

Once the platform arm has been lifted a few inches, rotate the top of the clip towards the front of the printer. Once in the correct position, the clip will slip over the Z-axis arm.

Next, open and check the contents of the Accessory Pack:

- Reel of Filament (1, Natural/White)
- Power Supply
- Power Cable
- USB Cable
- FR-4 (Perf) Board
- FR-4 Board Clips (6)
- Filament Guide Tube
- Filament Hanger
- Nozzle Wrench
- Hex Wrenches
- Spare screws & washers
- Gloves (1 pair)
- Putty Knife
- Exacto Knife and blades
- Snipping Pliers
- Tweezers

You will need the Power Supply and Cable, Hex Wrenches, Filament Spool, Filament Hanger, Filament Tube, and USB Cable to complete the Afinia H-Series 3D Printer installation.
Installing the Afinia H-Series 3D Printer

Attaching the Material Spool

Attach the Material Spool with these steps:

A. Connect the power adapter to the power interface and turn on the power switch.

B. Install the ABS plastic spool holder and filament guide. Unscrew the lower right screw from the left side of the Printer. Use this same screw to attach the spool holder with the bottom right lip of the spool holder locked onto the printer’s corner and the top of the holder mounted over the upper left screw.

C. Put the ABS Material Spool onto the holder with the end of the filament pointing up from the back. Thread the filament through the Filament Guide at the top of the spool holder.

D. Insert the end of filament into one end of the Filament tube. Feed the filament through the tube until about 4 inches of filament protrudes from the tube.
Driver and Software Installation

Mac
Insert the Installation Disc into your Mac. Open the disc, go into the Mac folder, and double-click the Afinia Mac Setup.pkg icon. Follow the prompts through the installation. The drivers will be added and the Afinia software will be installed to the Applications folder.

Windows
Insert the Installation Disc into your PC. If the installer does not launch automatically, start the Afinia H-Series 3D Printer setup.exe file in the PC directory on the installation disc and install to the specified directory (default is Program files\Afinia\Afinia 3D Printer).

Note: This installs the Afinia H-Series 3D Printer software, the Afinia H-Series 3D Printer drivers, and the Afinia H-Series 3D Printer sample files into your Program files\Afinia\Afinia 3D Printer folder.

Follow the instructions in the Installer to be sure the drivers and software are all in place before attempting to use the Printer. The instructions below will follow the same order as those in the Installer.

Installing the Printer

Mac
Simply connect the Printer to your Mac using the USB connection on the back of the Printer.

Windows Vista, and Windows 7
As part of the installation, the 3D Printer drivers are pre-installed and you will be prompted to connect the Printer to your PC. The Printer will be recognized and automatically installed when it is connected to your PC.

Windows XP
Since XP does not have the driver pre-installation ability, the drivers must be manually installed when the Printer is connected to the PC. Follow these steps:

A. Connect the printer to a computer with the USB cable. If the computer displays the “Found New Hardware Wizard” window, choose No, not this time, and click the Next button.

B. Choose Install from a list or specific location (Advanced) and click Next.
C. Select the option to **Search removable media**; the drivers are located on the installation disc.

If you are installing from a download, click **Browse**, then navigate to **C:\Program files\Afinia\Afinia 3D Printer\Driver**, then **Next**.

D. If the following dialog box appears, click **Continue Anyway**, and the drivers will install automatically.
Getting Ready to Print

Starting the Afinia 3D Program
If the application is not already open, click the Afinia 3D icon on the desktop (Windows) or in the Applications folder (Mac). The program should open and appear as shown below:

![Windows version](image1.png)  ![Mac version](image2.png)

Initializing the Printer
Before anything can be printed, the printer must be initialized. Click the Initialize option from the 3D Print menu. The printer will beep and the initialization procedure will begin. The printer will return the platform and print head to the printer’s origin and beep again when it is ready.

![Windows version](image3.png)  ![Mac version](image4.png)

The front Initialization Switch can also be used for initialization. Hold down the Initialization Switch for one second to trigger the initialization procedure.

**TIP:** If your printer is not responding properly, the first thing to try is to re-initialize the printer by clicking the Initialize option from the 3D Print menu.
Preparing the Platform

Before you start printing, the platform must be prepared so that the model adheres to the platform enough to be printed without the model moving. At the same time, you will want the model to be easy to remove from the platform after printing. There are several options for preparing the platform:

FR-4 Board (Glass-reinforced Epoxy Laminate)

Many users have reported excellent results by using a piece of FR-4 Board to cover the build platform. FR-4 Board is a perforated, glass-reinforced epoxy laminate sheet.

When using FR-4 Board, the first layer of the raft pushes plastic into all the perforations, and this provides a strong mechanical bond with the surface that prevents it from later lifting. The FR-4 Board can be either taped down (with masking tape or double-sided tape), or clipped to the platform as shown in the picture to the right. Make sure the clips are on the front and back of the platform only to avoid interfering with the platform movement!

It can be easier to remove the model from the FR-4 Board after the model has cooled down. As the plastic cools, it shrinks away from the perforations, which make it easier to pull out.

Some FR-4 Boards may work better than others. For consistent printing, it is recommended that you use the FR-4 Board included with the Printer.

Borofloat Glass

Many users have reported success using Borofloat glass as the print surface. In this method, an ABS and acetone slurry is made in advance, which is lightly brushed onto the glass and allowed to dry into a thin film of ABS.

The ABS film will hold the model to the heated glass, and will release from the glass as the glass cools. If the model does not easily release, spray a small amount of an ammonia-based glass cleaner around the model.

The same glass cleaner can be used to easily clean the film from the glass.

You will need to clean and recoat the print surface after each print if you will be printing the next model in the same location. Allow the slurry to dry fully before placing the glass on the print platform!

Whichever platform preparation method you use, the two factors that most reduce the risk of warping on large prints are ensuring that the platform is well leveled and well pre-heated.
Leveling the Print Platform

Before calibrating the nozzle height, always check the vertical nozzle distance from each corner and center of the print platform. Open the **Maintenance** dialog box from the **3D Print** menu and click the **Center** button to begin the leveling process.

If you already know the nozzle height, enter that height minus 2mm in the **To:** box, then click the **To:** button. If your nozzle height is 135.3, for example, enter **133.3**.

If you do not yet know the nozzle height, click the **To:** button to bring the platform to the displayed height, then slowly increment the height until the platform is about 2 mm from the nozzle, clicking **To:** after each increase.

Use the five position buttons to check that the platform at all four corners and the center are the same distance from the nozzle.

If the platform is not the same distance from the nozzle at all five points, you will need to adjust the platform until it is level. There are 3 thumbscrews under the platform that are used to level the platform.

Loosening a thumbscrew will raise the related corner of the platform, while tightening the thumbscrew will lower the same part of the platform. Adjust the thumbscrews as needed until all four corners and center of platform are the same vertical distance from the nozzle.

Always recalibrate the nozzle height after leveling the platform.

Calibrating the Nozzle Height

This section is probably the most important of the entire manual. Please read it carefully to ensure that you understand the nozzle height setup procedure, as it is vital to successful 3D printing.

To print successfully, the platform should be set to start at a distance of 0.2mm from the nozzle. As each printer is slightly different, this distance needs to be calibrated before starting to print.

To determine the correct nozzle distance, please follow these steps:

1. Open the **Maintenance** dialog box from the **3D Print** menu and click the **Center** button. The current nozzle height is indicated as shown in the **Maintenance** dialog images above. In the Windows example, the platform is currently at the bottom of the printer; the Mac example has the platform 135.5mm from the bottom.

2. Enter the height to which you want the platform to move to into the textbox and click the **To** button. In the above Windows example, the platform will move to **121** mm above the platform’s origin. In the Mac example, the platform is already at the height selected.
3. Check the distance between the nozzle and the platform. If the platform is currently at 121mm and appears to be about 12mm away from the nozzle, change the number in the text box to by 9mm to 130 and click the To button. Use small increments from there when calibrating the nozzle to avoid striking the platform into the nozzle.

4. Once you are about 1mm away from the nozzle, increase the number in the text box by 0.1mm increments and click the To button. Repeat until you get 0.2mm from the nozzle.

   **TIP:** An easy way to check the distance between the nozzle and platform is to fold a piece of paper in two, which will be about 0.2mm thick. Use this as a spacer to gauge the distance between the nozzle and platform.

5. Once you have the platform within 0.2mm of the nozzle, click the Set Nozzle Height button to save the current nozzle height.

6. Check the nozzle height at all four corners of the platform. Repeat the Platform Leveling and Nozzle Height Calibration processes if needed.

   **TIP:** If the platform contacts the nozzle while making height adjustments, it is good practice to re-initialize the printer and before undertaking any other operations.

### Platform Level Calibration

This process is not intended to replace manually leveling the platform. It should only be used if your print surface itself cannot be leveled due to warping or an inconsistent thickness.

If the platform surface cannot be leveled after performing the leveling and nozzle height calibration, there is a utility in the Afinia software that allows you to adjust the printing of the raft to level the model printing layers by dividing the print platform into several zones and entering adjustments for each.

Note that this will only affect printing when using a raft; if you are printing raftless, this utility will not affect print leveling.

Select **Platform Calibrate** from the 3D Print menu to open the utility.

First, find the highest of the 9 points on the platform. Click the button labeled 5 to move the nozzle to the center of the platform. Use the Up button to raise the platform; holding the button down will move the platform steadily, while single clicks can be used to fine-tune the platform height.

Raise the platform until the platform is just touching the nozzle and note the current height.

Next, click the Down button a few times to lower the platform then click the 1 button to check the platform at the back left corner.
Raise the platform again until the platform is just touching the nozzle. If the current height is lower than the previous point when the platform and nozzle first contact each other, use this point as the reference.

Repeat these steps for each of the 9 points on the platform. Once you have determined the highest point on the platform, move back to that point and adjust the platform position so the nozzle is again just touching the platform. Click the Set nozzle height button to change the nozzle height setting to that shown.

Once the nozzle height is set, use the 9 buttons to move to each position. Select the distance from the drop-down to the right of the selected position, choosing the value that will bring the platform into contact with the nozzle.

Perform this step with each of the nine positions. If you are using clips to secure the print surface to the platform, be careful to position the clips so they do not interfere with the nozzle or wind barrier.

Once all 9 values have been entered, click the Apply current values button.

If you need to perform this function again, click the Reset button to clear all values.

Click the Quit button when you are finished.

The adjustments in the example above, for instance, indicate that the print surface is warped, with the center higher than both the front and back edges. Using the Platform Level Calibration utility, you can correct for this warping.

This process is not intended to replace manually leveling the platform. It should only be used if your print surface itself cannot be leveled due to warping or an inconsistent thickness.
Loading the Print Material Filament

This process will be the same on both Mac and Windows.

A. Launch the Afinia H-Series 3D Software (refer to the software install procedure if you have not already installed it), and select Maintenance from the 3D Print menu. Click the Extrude button. After the printer nozzle has warmed up to 260° C, the printer will beep; you can also monitor the nozzle temperature in the Maintenance window under the 3D Print menu.

B. Be sure the filament is running through the filament tube between the spool holder and extruder!

C. Once the nozzle is heated, push the end of the filament into the hole at the top of the extruder head and hold it there with gentle pressure until the extruder motor starts pulling it through the extrusion head. The extruder will extrude a thin filament of material for a short period of time.

Other Maintenance Options

The Extrude button is used to load material into the nozzle. Click this button, and the nozzle will begin to heat. When the temperature is high enough (260° C), the material is squeezed out of the nozzle. The system beeps before material starts extruding, and it beeps again when finished. When changing the material (see page 29), use this function to load the new material to the nozzle. It can also be used to test whether the nozzle is working correctly.

Use the Withdraw button to clear the filament from the nozzle when you change the filament or if the nozzle needs to be cleaned. Once the nozzle is up to temperature (260°C) and the printer beeps, gently pull out the material.

The New Spool button is used by the software to keep track of how much material has been used, and warn you if you don’t have enough material left to print your model.

Click the button and enter the grams of material you have on the current spool. If it is a new spool, the weight should be set to the filament weight of the spool in grams. You can also specify whether the material you are printing with is ABS or PLA.
**TIP:** An empty Afinia Premium spool weighs about 280 grams. If you are installing a partially used Afinia Premium filament spool, weigh it, and subtract 280 grams from the weight. Enter that value into the material Weight text box.

**Status**
This area displays the current temperature of the nozzle and platform and if either element is currently being heated.

**Nozzle & Platform Position Controls**
The five buttons (FL, FR, Center, NL, NR) control the position of the nozzle and the platform. The nozzle moves to the left and right; the platform moves forward and backward.

The To button controls the height of the platform, and is used in the nozzle height calibration procedure described on page 13.

The Bottom button returns the platform to the lowest position.

**Set Nozzle Height**
Takes whatever value you have in the To box and saves it as the Nozzle height to use during printing.

**Stop All**
Stops heating and all the movement of the printer. Once you click this button, the current model being printed is cancelled. You CANNOT resume a print job once the printer has been stopped. After you use the Stop All function, you will need to re-initialize the printer.

**Pause Print**
This button allows you to pause a print in mid-progress while allowing you to resume the print job where it left off. This is very useful if, for example, you want to change the material color mid-print. Another use for pausing a job mid-print is to allow fasteners to be inserted into printed cavities and then printed over to lock the fastener into place.

This option is only available when the printer is actively printing and above the first four printed layers.

**Table Heat 1 hr**
Click the Table Heat 1 hr button to heat the table to 105º C for a full hour.

Heating the platform will not take the full hour, but the longer the platform heats, the more the outer edges of the platform will be heated. For prints extending close to the edge of the platform, this will help prevent warping of the model during printing.

**Note:** You should always preheat the platform prior to printing to ensure the best results.

**Stop Preheat (Windows) / Stop Heat (Mac)**
This button will halt any heating of the table, either the 1 hour heat or the 15 minute preheat from the 3D Print menu. This option only appears when the table in actively being heated by one of these two operations.
Printing with the H-Series 3D Printer

Loading a 3D Model

Click File / Open or the Open icon on the toolbar (Windows only) and select the model you want to open. The Afinia 3D Printer software only supports STL files (which is the standard input format for 3D printing files), the UP3 and UPP formats.

You can open several models and print them all at the same time. Simply repeat the open model procedure for each model you want to add (see Placing Models onto the Build Platform, page 21, for more information).

Insert Copy

You can also add multiple copies of the same model to the platform by selecting Insert Copy from the right-click options (Windows) or by selecting Copy from the Tools menu. Select the number of copies from the list.

You will need to reposition the models after the copies have been added.

Unloading the Model, Windows

Click the left mouse button on the model to select it, and then click Unload on the toolbar, or click the right mouse button while over the model and a context menu will appear. Choose Unload using the model name or Unload All models if you have more than one file open and want to remove all of them.

Unloading the Model, Mac

Use either the Unload or Unload All button in the right tool pane. Click the Unload button to remove the currently selected model, or Unload All to clear all models from the workspace.
Saving the model
Choose the model and select **Save** from the **File** menu. The file is saved in UP3 format with the file size being 13%-18% of the original STL file size. This is a convenient format for users to archive or transfer files.

Saving the model as a project
Choose the model and select **Save As Project** from the **File** menu. All of the settings within the **Setup** or **Preferences** will be saved, as well as the **Quality** and **No Raft** settings. Along with the settings, the model itself is saved using the UP3 format.

The settings that are not saved within a project include the **Nozzle Height**, **UnSolid Model**, **Heat platform after finish**, and **Pause at** settings.

The project file will be saved with an extension of UPP. This one file can be copied to other locations or computers without needing to include the original STL file or files.

**Note on STL files:** For a model to print correctly, all the faces of the models need to have their normal facing outwards. The Afinia H-Series 3D Printer software uses model color to indicate whether a model is OK or not. The default color used by the software when opening a model is a light grey/pink color. If the normal are facing the wrong way, then the model is colored in red.

Fixing STL Files
The Afinia 3D Printer software includes a Fix option that attempts to fix any model that includes bad surfaces. Under the **Edit** menu in Windows you will see the **Fix** option, and under the **Tools** menu in Mac will be the **Autofix** option. Select the model with inverted surfaces, and click the **Fix** or **Autofix** option to attempt a repair of the bad surfaces.

Merging Models
If you have loaded more than one part onto the platform, you can combine them into a single file by using the **Merge** option from the **Edit** menu in Windows or the **Tools** menu in Mac. Simply open all the models you want to merge, arrange them the way you want on the platform, and click the **Merge** option. When you then save the file, all the components will be saved as a single UP3 file.
View Options
To observe the target model in different ways, use the mouse to control the view.

Rotate
Press the middle mouse button and move the mouse. The view can be rotated and observed from different angles.

Pan
Press Ctrl and the middle mouse button at the same time and move the mouse. This causes the view to pan. You can also use the arrow keys to pan the view.

Scale
Rotate the mouse wheel. The view will zoom in or out.

View
The system has eight preset standard views available, with the default view being Fit. Click the View button on the toolbar (Windows) or the View menu to select the View options.

After selecting an option, the caption under the View button will show the selected view name.

Model transformations
Model Transformation can be achieved through the Edit menu or the toolbar:

Moving the Model
Click the Move button and choose or input the distance you want to move into the text box. Then choose the axis (direction) in which you want to move. Each time you click the axis button the model will move again.
For example: To move the model -5mm along Z axis (or down 5mm):

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click Move</td>
<td>1. Select the Move option</td>
</tr>
<tr>
<td>2. Input -5 in the text box</td>
<td>2. Input 5 in the text box</td>
</tr>
<tr>
<td>3. Click the Z axis button</td>
<td>3. Click the Z- button</td>
</tr>
</tbody>
</table>

**Windows TIP:** If you hold down the Ctrl key, you can drag the model to a position.

**Rotating the Model**
Click the Rotate button on the toolbar, choose or input how many degrees you want to rotate in the text box, and then choose the axis of rotation.
For example: To rotate the model around Y axis by 30°.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click Rotate</td>
<td>1. Select the Rotate option</td>
</tr>
<tr>
<td>2. Input 30 in the text box</td>
<td>2. Input 30 in the text box</td>
</tr>
<tr>
<td>3. Click the Y axis button</td>
<td>3. Click the Y+ button</td>
</tr>
</tbody>
</table>

Positive numbers rotate the model counterclockwise; negative numbers rotate the model clockwise.

**Scaling the Model**
Click the Scale button on the toolbar, choose or input a scaling factor in the text box, and then scale the model uniformly by applying that scaling factor.
If you only want to scale along one axis, click the axis around which you want the change to be applied.

**Example 1:** Scale up the model uniformly by 2.0 times.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click Scale</td>
<td>1. Select the Scale option</td>
</tr>
<tr>
<td>2. Input 2.0 in the text box</td>
<td>2. Input 2.0 in the text box</td>
</tr>
<tr>
<td>3. Click the Scale button</td>
<td>3. Click the Scale button</td>
</tr>
</tbody>
</table>

**Example 2:** Scale up the model by 1.2 times along the Z axis only.

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click Scale</td>
<td>1. Select the Scale option</td>
</tr>
<tr>
<td>2. Input 1.2 in the text box</td>
<td>2. Input 1.2 in the text box</td>
</tr>
<tr>
<td>3. Click the Z Axis button</td>
<td>3. Click the Z+ button</td>
</tr>
</tbody>
</table>
Example 3: Scaling to convert inches to mm.

Occasionally an stl file may appear much smaller or much larger than designed. This is due to the design software saving the units of measure as inches rather than millimeters; the Afinia 3D software uses millimeters only, so a 1 inch model would appear as 1 millimeter.

This is simple to resolve using the following steps:

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click <strong>Scale</strong>&lt;br&gt;2. Select or input <strong>25.4</strong> in the text box&lt;br&gt;3. Click the <strong>Scale</strong> button</td>
<td>1. Select the <strong>Scale</strong> option&lt;br&gt;2. Input <strong>25.4</strong> in the text box&lt;br&gt;3. Click the <strong>Scale</strong> button</td>
</tr>
</tbody>
</table>

Conversely, if the model initially appears much too large, you can convert the size from millimeters to inches by selecting (PC only) or entering **0.03937** into the text box and clicking the **Scale** button. This does not actually convert the models measurements, just scales it in the selected direction.

Placing Models onto the Build Platform

Appropriately placing your models on the platform can have an effect on print quality.

**TIP:** In general, try to place your model in the center of the platform.

**Auto Place**

Click the **Auto Place** button, on the far right of the toolbar, to automatically place the model on the platform. When there is more than one model on the platform, using Auto Place is recommended.

**Windows TIP:** Check the **Auto Place** option in the **File** menu to automatically position the model on the platform when the model file is opened.

**By Hand (Windows)**

Press the **Ctrl** key and choose the target model by pressing and holding the left mouse button. Move the mouse and drag the model to the desired position.

**Using the Move button**

Click the **Move** button (Windows) or the **Move** parameter (Mac) on the toolbar, choose or input the distance in the text box, and then choose the axis for the direction in which you want to move.

**NOTE:** When more than one model is open, the gap between each model should be kept to at least 12mm to prevent the models sticking together.
Print Setup Options
Click the Setup option in the 3D Print menu or the Preferences button on the Print and Print Preview windows. The following dialog box will appear:

Print Settings
Z Resolution
This setting specifies the print resolution or layer thickness of the printer. Options are 0.15mm to 0.40mm per layer, in 0.05mm increments, with the most current Printer ROM version applied.

Part Settings
Angle
The Part Angle sets the horizontal printing orientation for fill printing. Set at 45 Deg, the part will be filled in with material printed at 45 degrees to the X- and Y-axes. Changing the value will change the print angle to that selected, with the angle of each layer still being printed perpendicular to the one below.

The orientation of the part itself will not be changed, just the angle at which the fill material is printed. This setting will also not change how the perimeter of the model is printed.

Surface
This setting determines how many layers form the bottom face of a part when it is not solid. For example, if you set it to 3, the machine will print 3 complete layers before going into non-solid mode.

This does not affect the side wall thickness on non-solid parts, which are all the same thickness (approximately 1.5mm) regardless of the fill mode.
Fill Settings
There are four ways to fill the interior of the parts, as described below.

<table>
<thead>
<tr>
<th>Mac setting: Solid</th>
<th>Mac setting: Loose</th>
</tr>
</thead>
<tbody>
<tr>
<td>The part is nearly solid plastic, giving you the strongest structure. This Fill setting is recommended for functional engineering parts.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mac setting: Hollow</th>
<th>Mac setting: Big Hole</th>
</tr>
</thead>
<tbody>
<tr>
<td>The interior of the part is filled with a medium spaced scaffold structure.</td>
<td></td>
</tr>
<tr>
<td>The interior of the part is filled with a large spaced scaffold structure, using the least amount of material.</td>
<td></td>
</tr>
</tbody>
</table>

For example, when printing a sphere 4cm in diameter at 0.15mm resolution, the most open fill setting, and the rest of the settings at the default values will use 9.3 grams of filament and print in 61 minutes. Checking the Shell setting will reduce the material use to 5.4 grams and print time to 36 minutes by not printing the fill material.

Some models may not be suited to printing with the Shell setting checked.

This will not affect the printed model's wall thickness or support material requirements.

Surface
Selecting the Surface setting will allow you to print a model as a single-layer outline of the model perimeter. Note that this setting will not work with models having a base, solid top, or requiring any inner fill structure.
Support Settings

Dense
This represents how many layers of dense support material is printed directly beneath the model. The greater the number of dense support layers, the more stable the print will be but the support will be more difficult to remove.

Angle
The Support Angle setting specifies the maximum Angle at which support material will be printed. If the angle from horizontal is smaller than the selected setting, the printer will add solid support layers under the part surface.

For example, if the setting is 10 Deg, only surfaces that are within 10 degrees from horizontal will be printed with support material to hold them up. Increasing the setting to 50 Deg will result in support material being printed for surfaces that are within 50 degrees from horizontal.

Increasing this value will add more material and time to the print. Decreasing this value may result in poor printing of overhanging surfaces.

There is a balance between minimizing the amount of support material and maintaining the quality of the part, as well as minimizing the difficulty of removing support material.

The orientation of the part on the print platform is critical in determining both how much support material gets used and how difficult the support material will be to remove.

As a general rule, it is easier to remove support material from the outside of a part than from the inside. As can be seen in the picture to the right, the part would use a lot more support material if printed with the opening facing downwards than if it were facing upwards.

Space
This setting specifies the distance between the lines of non-solid support material. Changing this parameter changes the balance between the quantity of support material used, ease of support material removal, and part print quality. Only advanced users should change the Space setting.

Area
This setting specifies the surface area above which support material is printed. When you choose 5 mm², for example, there will be no support if the overhanging area is less than 5mm². While a little material is saved and a slightly faster print speed is achieved when this setting is increased, the stability of the part may be reduced during printing.
Two special options for the Support Area setting are available. The **Only Base** setting will use a minimum of support material. In many cases, no support material other than that needed to support the base of the model will be used. The **0 mm²** setting will create support material when the Angle criterion is met regardless of the surface area.

**Other Settings**

**Stable Support**

Stable support creates support that is more solid, and the model is less likely to distort, but the support material will be more difficult to remove. This can be useful where tall, narrow support is needed.

**TIP:** All setup and configuration settings aside from the Nozzle Height Calibration and Platform Leveling parameters are stored in the software, not on the Afinia H-Series 3D Printer. If you move the printer to a different computer, you will need to repeat all the calibration and setup procedures.

**Printing**

**TIP:** One of the keys to successful printing on the Afinia H-Series 3D Printer is **platform preparation and preheating**. Particularly with large parts, there is a tendency for the edges of the part to lift from the platform (which can be a little colder than the center) and cause the parts to warp. The best results will be achieved if:

- The platform is perfectly level and calibrated
- The nozzle height is correctly set
- The printer is being run in a room that is not too cold (warmer than 65°F) and free of drafts
- **The platform is very well preheated**

Please ensure the following points are taken care of before printing:

Connect the 3D printer, initialize it, and set up the printing system. Load the model and place it properly on the virtual platform of the software window. Check if there is enough material for the model (use the Print Preview to calculate the required material, or the software will tell you if there is not enough material when you begin the print). If not, change the spool to a new one.

For most surface preparations, it is recommended that you preheat the build platform. Click the **Table Preheat 15 mins** option in the 3D Print menu or click the **Table Heat 1 hr** in the Maintenance window to preheat the platform.

*Let the platform heat to at least 90° C when printing with ABS before beginning the print. Select Maintenance from the 3D Print menu to monitor the platform and nozzle temperatures.*

Click **Print** from the 3D Print menu.
Print Options

Nozzle Height
You can make changes to the Nozzle Height using this setting, but it is not recommended unless you know that the value you are entering is correct.

If the nozzle is too far from the platform during printing, the material may not adhere correctly to either the platform or to the previous layer.

If the nozzle height is set too high, the platform can raise up into contact with the nozzle itself, potentially damaging the nozzle.

It is recommended that you use the Calibrate Nozzle Height process as listed on page 13 to make any changes rather than in the Print dialog.

Quality
Options are Normal, Fast, or Fine. This setting determines the speed at which the printer moves. As a general rule, the slower you print the better the quality of the parts, although there are exceptions to this rule.

For tall parts, running at Fast speed can be problematic as the printer can vibrate to the extent that print quality is affected.

For large surface area parts, the Fine setting can be problematic as the part takes longer to print and the corners of the raft are more likely to lift from the platform.

UnSolid Model
This function is useful for printing STL files that are not perfect. A perfect STL file is a fully enclosed surface, with no holes in the surface skin, and no overlapping surfaces. If your file is not perfect, this option should allow you to print it anyway.

The software will auto-detect models that may require this setting and check this option. You can manually remove the check to de-select this function if needed.

No Raft
While you can choose to skip the Raft with this option, it is not recommended. The raft adds stability to the adhesion between the part as it is printing and the platform.

Additionally, the Platform Calibrate feature (see page 14) which can compensate for an uneven print surface will be bypassed if the raft is not printed.

Heat Platform after finish
Checking this option will keep the platform temperature at a higher level after printing is complete. This can make it easier to remove the model from the platform, depending on the platform preparation, or keep the platform heated to begin your next print more quickly.

Pause At
You can use this option to automatically pause the printer at specific heights during the printing process. This can be useful if you will be changing filament or inserting a non-printed part at a specific point during the printing of the model. Multiple heights can be entered into the setting, separated by commas. The height uses millimeters as the scale.

For instance, entering 13.5, 20, 27.25 will automatically pause the printing when it has reached 13.5 millimeters, 20 millimeters, and 27.25 millimeters.

The height is based on the model only. If you are printing with a raft, you do not need to add the height of the raft to the numbers you add in; the software will do so for you.

Once the print has auto-paused, open the Maintenance window to perform the Withdraw, Extrude, and Resume Print functions.
Calculating model costs

The easiest way to calculate the cost of the material that will be used for your model is to use the Print Preview option under the 3D Print menu. The application will calculate the total weight of material used, including the raft and any support material.

Use the weight from the Print Preview to determine the cost to print the model using the following formula:

\[
\text{Cost to Print} = \text{Weight of Model} \times \left( \frac{\text{Cost of Spool}}{\text{Full Filament Weight}} \right)
\]

Use the full weight of the filament that you purchased, not the current weight of the spool. For instance, if you purchased a 700g spool of Afinia Premium ABS filament, you would divide the cost of the spool by 700g to get the cost per gram of material.

The main factors that affect model cost are the Fill and Support settings. For example, you are printing a cube measuring 30mm x 30mm x 30mm with a layer thickness of 0.15mm. With the Support settings left at their default values, the following quantities of material will be used for each of the four Fill settings:

<table>
<thead>
<tr>
<th>PC Fill Setting</th>
<th>Mac Fill Setting</th>
<th>Fill Percentage</th>
<th>Weight of Model</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Solid</td>
<td>50%</td>
<td>17.7 g</td>
</tr>
<tr>
<td></td>
<td>Loose</td>
<td>25%</td>
<td>12.0 g</td>
</tr>
<tr>
<td></td>
<td>Hollow</td>
<td>17%</td>
<td>9.1 g</td>
</tr>
<tr>
<td></td>
<td>Big hole</td>
<td>12%</td>
<td>8.2 g</td>
</tr>
</tbody>
</table>

Note: Shell and Surface fill settings results are not shown, as the model used is not one that would print well in either mode due to the horizontal surfaces.

In this example, the model printed at the lowest density Fill setting will be about half the cost as printing it at the highest density Fill setting, but this may not apply to all models. Each model will have a different relationship between the amount of material used and the Fill and Support settings. Always run a Print Preview if you are calculating the printing costs of any given model.

TIP: Once the print has started, you can unplug the USB connection between the computer and the printer. The print job is stored in the printer’s internal memory, so the computer is no longer required. If you need to interact with the printer during the print (paused printing, for instance), you will need to reconnect the printer to the computer.

Save as Project

Once you have all the parts on the platform and the print settings the way you want them, you can use the Save as Project option under the 3D Print menu to create a 3D print project. All of the settings within the Setup or Preferences will be saved, as well as the Quality and No Raft settings. Along with the settings, the model itself is saved using the UP3 format.

The settings that are not saved within a project include the Nozzle Height, UnSolid Model, Heat platform after finish, and Pause at settings.

The project file will be saved with an extension of UPP. This one file can be copied to other locations or computers without needing to include the original STL file or files.
Model Removal

When the model has finished printing, the printer will beep, the nozzle and platform will stop heating, and the printer platform will lower.

It is very strongly recommended that you never attempt to remove the finished model from the platform while in the printer. If you do, you may bend the entire platform assembly so that it is no longer perpendicular to the printer head or affect the platform leveling.

If your print surface is attached directly to the printer platform, detach the printer platform from the printer by removing the 2 screws at the bottom of the platform before attempting to remove the model.

If you are using any method that clips another surface to the printer platform, simply remove the clips holding the surface to the platform and remove the entire surface.

**Removal from FR-4 (Perf) Board**

Gently slide a spatula or chisel under the model and slowly wiggle it back and forth to lift the support material from the print surface.

Remember to use gloves as the board and model may still be hot and to prevent injury from any tool being used to help release the model from the FR-4 Board.

**Removal from Borofloat Glass**

After removing the glass from the printer platform, allow the glass to cool completely. As the glass cools, you may hear audible cracking sounds – this is the ABS film contracting and detaching from the surface of the glass.

If the model does not release completely from the surface of the glass, spray a small amount of an ammonia-based window cleaner onto the surface of the glass near the edge of the model. After a few moments, the model should release.

With the glass surface, you will need to reapply the ABS film after removing each print job.

**TIP:** Depending on the platform preparation method you are using, the model may be easier to remove from the printer when it is still hot. If you want to heat the platform before removing your model, use the **Table Heat** option from the **3D Print** menu.

---

<table>
<thead>
<tr>
<th>CAUTION:</th>
<th>It is strongly recommended that you do not attempt to remove the model from the platform while the platform is still attached to the printer. Doing so may damage the printer or affect the platform level and nozzle height calibration.</th>
</tr>
</thead>
<tbody>
<tr>
<td>GLOVES:</td>
<td>It is recommended that gloves be worn as the platform may still be hot and to prevent injury from any tool being used to help remove the model from the platform.</td>
</tr>
</tbody>
</table>

---

29
Removing Support Material
Printed models are composed of two parts. One part is the model itself, and the other part is the support material used to support any overhanging parts of the model.

The support material is the same physical material as the model material, but printed at a much lower density. Support material is very easy to distinguish from the model material, making it is easier to remove.

The left picture above shows the teapot with its support material still attached, while the right picture shows the teapot with support material removed.

The support material can be removed using a combination of tools. Some material can easily be removed by hand. Support material close to the model is easier to remove using tools such as wood carving chisels, long nose pliers, or wire cutters.

GLOVES/SAFETY GLASSES: The support material and the tools are sharp. Wear gloves and safety glasses when removing the part from the printer.

ALWAYS WEAR GLOVES AND SAFETY GLASSES WHEN REMOVING THE SUPPORT MATERIAL!
Maintenance

Changing the Material
First withdraw the leftover material from the printer. Initialize the printer and choose Maintenance from the 3D Print menu. Click the Withdraw button and the nozzle will start to heat. When the nozzle reaches the correct temperature, the printer will beep and you can gently withdraw the material.

Once the old filament has been removed, place a new spool of material on the spool holder and pull the filament through the slot in the top of the holder. Feed the filament through the filament tube until the material is about 10cm out of the tube. Insert the end of the filament into the hole at the top of the extruder head.

Before extruding the new filament, use the New Spool function to set the temperature to the selected filament type and to help the sprinter keep track of the amount of filament that is available using the Material and Weight settings, respectively.

Click the Extrude button. After the printer nozzle has warmed up to the correct temperature, the printer will beep. Gently push the filament into the hole at the top of the extruder head with a little downward pressure until the extruder mechanism starts to feed the filament through on its own.

TIP: If you are loading a different color filament than the last spool, run the Extrude function a few times immediately after the new spool is in place. This will help extrude out any remaining filament material of the previous color.

<table>
<thead>
<tr>
<th>!</th>
<th>CAUTION: If the nozzle is blocked, remove the nozzle and clean it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>☣️</td>
<td>GLOVES: The extruder and platform are hot. Use gloves when working in this area of printer.</td>
</tr>
</tbody>
</table>

Vertical Calibration
The Vertical calibration procedure allows you to ensure that the printer platform is perfectly horizontal and that the printer prints consistently in the X, Y, and Z directions.

First, print the supplied Calibration model on your printer at the scale of the part when initially opened. The calibration file is in C:\Program Files\Afinia\Example on PCs and in the Afinia directory off the root of the main drive on Macs.

After the calibration model is printed, remove the platform without removing the parts.
Open the Calibrate dialog from the 3D Print menu. Measure the X1 and X2 length, as shown in the pictures below.

**IMPORTANT NOTE:** Before you enter any new calibration values, always click the Reset button, otherwise the new values get added to the old ones. Before you enter any new values, the bar at the very top of the screen should read: XY: 0.00 deg / XZ: 0.00 deg.

Measure the calibration print from front left to rear right corners of the printed parts on the platform to determine the X1 measurement, and the rear left to front right to determine the X2 measurement. Be sure that you are not including the raft or support material when taking these measurements!

Enter the measured X1 and X2 values into the appropriate boxes.

Next, carefully remove the Front Center 'L' shaped component from the platform and check the inside angle. If it is not 90º, measure the exact distance in millimeters that the end of the long arm of the part would need to move to get the angle to be 90º and enter that distance into the Z box. If the angle is less than 90º, the value to be put into the Z box will be a positive value. If the angle is more than 90º, the value to put into the Z box will be a negative value. For example, if the end of the long arm is 1.3 mm above the surface, enter -1.3 in the Z box.

Finally, measure the long arm of the Front Center component from the inside of the angle to the end, which should be 40mm at full scale. Enter the exact measured value into the H box of the Calibrate dialog box.

Click OK to record all these values and exit the calibration window.

**Cleaning the nozzle**

After a lot of printing, the nozzle may be covered with a layer of oxidized filament material. When the printer is printing, this oxidized material may melt on the nozzle, and may create discolored spots in the model or even clog the nozzle. To avoid this you need to regularly clean the nozzle.

Preheat the nozzle as the first step in order to melt the oxidized filament. Click the To Bottom button on the Maintenance dialog box, and then click the Extrude button. Wait until the material is finished extruding, then remove any extruded filament from the nozzle.

Use a heat-resistant material such as 100 percent cotton cloth or soft paper and a pair of pliers. With the material between the pliers and the nozzle, apply gentle pressure with the pliers and turn the pliers to remove the oxidized filament material. **Do not apply heavy pressure!**
Remember, the nozzle heats up to 260° C (500° F) – that’s over two and a half times the boiling point of water.  **Do not touch the nozzle or nozzle mount with bare skin during this process!** If this does not clear up any issues, you should try removing and soaking the nozzle in acetone overnight to remove excess ABS material from the nozzle.  Ultrasonic cleaning baths also work.

### Removing / Changing the Nozzle

If the nozzle becomes blocked, you may need to remove it in order to unblock or change it altogether.  To remove the nozzle, use the **Withdraw** button on the Maintenance dialog box to remove as much filament from the nozzle as possible.  Once the Withdraw has completed and before the heater has a chance to cool below 200° C, use the nozzle wrench provided in the toolkit that comes with your Afinia H-Series 3D Printer.  Use the same process to replace the nozzle, being sure to heat the extruder to at least 200° C before tightening the nozzle back down.

Do not apply too much torque to the nozzle to avoid twisting the heater assembly!

**TIP:** Heating the nozzle will make it easier to remove and replace.

**WARNING:** Be careful when handling the heated nozzle and nozzle wrench once the nozzle has been removed!

### Cleaning the Platform

Regardless of the method of preparing the platform that you have chosen, a smooth surface will improve your results.

- If you are using the FR-4 Board as the print surface, you should remove any remaining filament material from the surface of the board before printing again.
- If you are using blue painter’s tape on the platform, you will need to replace the tape once it becomes uneven.  You may need to remove excess adhesive from the platform during the process of replacing the tape.

### Lubrication of bearings

The 3 axial bearings on the Afinia H-Series 3D Printer may occasionally require a bit of lubrication to keep it operating smoothly.  The recommended grease to use is lithium grease.  When lubricating the bearings, first clean off as much old grease as possible from the bearings before applying new grease to the bearing.  Slide the platform several times in the appropriate direction to spread the grease evenly.

If you have any questions about lubricating the bearings, please contact Technical Support (see page 36 for contact information).

### Spare parts

Most of the plastic parts on the printer can be printed by the Afinia H-Series 3D Printer itself.  If you need spare parts for your printer, the files for the printable parts can be found in the `C:\Program Files\Afinia\Example\Spare Part` folder on PCs and in the `Afinia` directory off the root of the main drive on Macs.
Tips & Tricks

Preheat the platform before printing
Large parts can sometimes have their corners lift from the platform, which causes the part to distort. This is caused by uneven heat across the surface of the platform.

Preheating the platform (see page 26) to at least 90 degrees C when printing with ABS is a step you don’t want to miss. Having the platform heated before print starts helps ensure that the model will remain adhered to the platform during printing.

You can monitor the platform temperature in the Maintenance window.

Level Platform and Correct Nozzle Height
One key to both successful printing and removal of the print raft is to make sure the platform is level and that the nozzle height is set correctly. Use the Maintenance window to bring the nozzle close to the print surface, then the Platform Calibration utility to level the platform and set the nozzle height (see pages 13-14).

Be sure to use the calibration utility to help compensate for any parts of the print surface that aren’t level!

Position the parts as close to the center of the platform as possible
The center of the platform is where the heating is most regulated, which helps to keep the support raft adhered to the platform. Try to avoid printing any object near the edges of the platform.

Model Orientation Tips
Generally, follow these three simple tips on model orientation for better print results:

a) Position the model so the largest flat surface is on the bottom
b) If your model has any cylindrical parts (either solid or holes), position them so they are vertical
c) Minimize support material by orienting the model with as many concave surfaces up as possible

Remember, these tips may not be able to be applicable to all models. Each model is unique and each has the best orientation for printing.

Scaling your Model
Not only can the Afinia 3D software scale your model in all three dimensions, you can use the Scale function to change the size in any one of the three dimensions independently. For instance, you can make your model taller by setting the scale factor and clicking just the Z Axis button without affecting the width or depth (see page 21).

Merging and Rafts
Positioning multiple models too closely in the software can result in overlapping rafts, which can lead to printing failure. If you do change the model positions once they’ve been positioned automatically, use the Merge function in the Edit menu before printing to have the software eliminate that problem by creating a single raft where they may be overlapping.

Be sure to save these merged models if you will be regularly printing them as a group!

Minimal Support Material Use
The latest versions of the Afinia 3D Software includes a feature that allows you to avoid most support material. When specifying the Print Preferences, select Only Base for the Support Area setting (see page 25-26).

Support material around the bottom of the model will still be generated, but the amount of support material will be greatly reduced.
Shell Setting Tips
The Shell option for the print Fill setting can be used to create truly hollow prints, saving time and material. However, not all models can be printed with this fill setting.

Models with relatively small horizontal or near-horizontal surfaces are potential candidates for shell printing, as these surfaces require little or no internal support to be successfully printed. Remember, each model is different – you may need to experiment with each model to find out if it can be used with Shell printing.

Decrease print time where possible
The faster you can print parts, the less lifting from the platform you are likely to get. Some ways to increase print quality include:

- If possible, try to avoid printing large parts in solid mode
- Set the layer resolution to as large a value as possible while still retaining the quality needed for the finished part
- Print the part in Normal or Fast mode
- If printing multiple parts at once, reduce the number of parts that are being printed

Pause During Print: Changing Filament
If you need to change the filament during printing, you can either use the Pause Print button in the Maintenance window or enter in automatic pauses when you are setting up the print parameters (see page 27).

When paused, click the Withdraw button to remove the current filament. After changing filaments, insert the new filament and click the Extrude button to load your new filament.

If you have changed colors, you may need to extrude a few times to remove the last of the previous filament color.

Keep the extruded filament connected to the nozzle – pull it from the nozzle just before the nozzle contacts the print surface when resuming the print to keep any stray strands from sticking to your model.

Model Creation: What does “Manifold” mean?
For any model to print correctly, it should be a manifold object. What this means is, as simply as possible, is that each edge must be in contact with two and only two surfaces. Most design software will allow you to create non-manifold objects, which can result in print problems.

The most common way for a model to become non-manifold is when several objects are joined together, creating surfaces in the model that are in contact with or crossing through each other.

The Fix function in the Edit menu of the Afinia 3D software may repair the non-manifold problem areas, but the best solution is to correct any problems in your design software. Many software packages have functions to check for and repair any non-manifold models – the documentation for your software should be consulted.

Model Creation: What does “Surface Normalization” mean?
The outer layer of every 3D printed object is actually composed of an outer surface and an inner surface. Surface Normalization means these surfaces are pointing the correct way. If you have an outer surface buried inside your model, or have an inner surface on the outside of the model, you will need to normalize the surfaces.

The most common way for non-normalized surfaces to appear is when two surfaces cross each other in the model.

The Fix function in the Edit menu of the Afinia 3D software may resolve the surface problems, but the best solution is to correct any problems in your design software. Many software packages have functions to check for and remove any non-normalized surfaces – the documentation for your software should be consulted.
# Status Indicator

The table below explains what each Status Indicator state means.

<table>
<thead>
<tr>
<th>LED State</th>
<th>Indicates:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Red</td>
<td>Printer is not initialized; initialize printer either using the software or the initialize button on the front.</td>
</tr>
<tr>
<td>Solid Green</td>
<td>Printer is Ready</td>
</tr>
<tr>
<td>Flashing 10 times per second</td>
<td>Data is transferring to printer</td>
</tr>
<tr>
<td>Flashing 5 times per second</td>
<td>1. Extruder is heating or 2. Extrude or Withdraw Material function in progress</td>
</tr>
<tr>
<td>Flashing about 2 times per second</td>
<td>Printing in progress</td>
</tr>
<tr>
<td>Flashing about every 2 seconds</td>
<td>Printing has stopped</td>
</tr>
<tr>
<td>Rapid strobing between green and red</td>
<td>Printer is in an error state; power cycle and re-initialize the printer</td>
</tr>
</tbody>
</table>
# Troubleshooting

<table>
<thead>
<tr>
<th>Problem or Error message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No power</td>
<td>Verify power cord is securely plugged in</td>
</tr>
<tr>
<td>Extruder or platform fails to reach operating temperature</td>
<td>Verify printer has initialized. If not, initialize the printer (see page 11)</td>
</tr>
<tr>
<td></td>
<td>Heater is damaged. Contact Technical Support (page 38)</td>
</tr>
<tr>
<td>Material not extruding</td>
<td>Material is stuck in the extruder; remove the material (see page 31)</td>
</tr>
<tr>
<td></td>
<td>The nozzle is clogged and needs to be cleaned (see page 32) or changed (see page 33)</td>
</tr>
<tr>
<td>Cannot communicate with printer</td>
<td>Printer not initialized; use Initialize button on front or Initialize function in software</td>
</tr>
<tr>
<td></td>
<td>Make sure the USB cable is connected to the printer, and to the PC</td>
</tr>
<tr>
<td></td>
<td>Unplug the USB cable, then plug in again</td>
</tr>
<tr>
<td></td>
<td>Reset the printer—power off then power on</td>
</tr>
<tr>
<td>Others</td>
<td>Contact Technical Support (see page 38)</td>
</tr>
</tbody>
</table>

## Solution for "Winusb.dll not found" problem (Windows)

If you encounter a “Winusb.dll not found” error message, please follow the steps below:

### Option 1: Uninstall Older Driver and Auto-Install New Driver

1. Open the Windows control panel, go to the **System Properties** dialog box and select the **Hardware** tab.

2. Click the **Device Manager** button, and the following dialog box will popup. Find the **3DPrinter@FreeMC** in the USB section.

3. Click the right mouse button and select the **Uninstall** option. The confirm dialog box will appear. Click **OK**.

4. Install the latest Afinia H-Series 3D software.

5. Unplug the USB cable, then plug it back in. Windows will find a new device. Manually select the driver folder (the default location is `C:\Program Files\Afinia\Afinia 3D Printer\Drivers`).
6. There should now be a new driver section in the device manager as shown to the right.

Option 2: Update the driver manually
1. Install the latest Afinia H-Series 3D Printer software.

2. Find the 3DPrint@FreeMC driver in the Device Manager dialog box (it should be located in the USB section).

3. Right click the entry and select Update Driver.

4. Select the Afinia H-Series 3D Driver folder (the default is C:\Program Files\Afinia\Afinia 3D Printer\Drivers).

5. A Free Motion Card entry should appear in the Device Manager list.
Updating the Printer ROM

*Note: This is a function that should only be performed if necessary.*

The H479 Printer ROM can only be updated using the Windows version of the Afinia Software. Follow these steps to perform the update:

1. With the H479 Printer on and initialized, select **Update ROM** from the **Tools** menu.
2. Click the **OK** button in the dialog asking you to confirm that you want to update the ROM.
3. Click **OK** in the next dialog to select the ROM update file.
4. Use the browse dialog to find the updated ROM file. This file will be located in the `C:\Program Files\Afinia\System` folder. The file name will include the ROM version just before the `.ROM` file extension.
5. Click the **Open** button when the correct file is selected.
6. Verify that you have selected the correct file and click **OK**. Click **OK** again to begin the update.
7. When notified that the update is complete, follow the prompts and power cycle the H479.
8. Initialize using the hardware button on the front of the Printer.
9. Select **About Afinia** under the **Help** menu and verify that the new ROM version has been applied.

Specifications

### Printer Physical Characteristics

<table>
<thead>
<tr>
<th>Printing Material</th>
<th>ABS or PLA Plastic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer Thickness</td>
<td>0.15 – 0.40 or 0.20 – 0.35 mm, depending on model, ROM version</td>
</tr>
<tr>
<td>Nozzle Diameter</td>
<td>0.40mm</td>
</tr>
<tr>
<td>Print Speed</td>
<td>10 – 100 cm³/h</td>
</tr>
<tr>
<td>Print Size</td>
<td>140×140×135mm</td>
</tr>
<tr>
<td>Printer Weight</td>
<td>11 lb (5 KG)</td>
</tr>
<tr>
<td>Printer Size</td>
<td>245 × 260 × 350 mm</td>
</tr>
</tbody>
</table>

### Specifications

<table>
<thead>
<tr>
<th>Power Requirements</th>
<th>100-240 VAC, 50-60 Hz, 200W</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Support</td>
<td>Auto-generated Support</td>
</tr>
<tr>
<td>Input Format</td>
<td>STL, UP3</td>
</tr>
<tr>
<td>Workstation compatibility</td>
<td>Win XP/Vista/Win7/Mac OSX</td>
</tr>
</tbody>
</table>

### Environmental specifications

<table>
<thead>
<tr>
<th>Ambient temperature</th>
<th>60°F ~ 85°F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative humidity</td>
<td>20% ~ 50%</td>
</tr>
</tbody>
</table>
Technical Support
For technical questions or support issues, contact Afinia Technical Support:

PH: 952-279-2643
support@afinia.com
www.afinia.com

Please have the Model and Serial Number of your Afinia H-Series 3D Printer available when contacting Technical Support.

Date of Purchase: ______________________

Place Purchased: __________________________

Serial Number: ____________________________
(Located on back of Printer)

Notes